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1.1 WHAT IS AUTOCAD®?

AutoCAD® was one of the fi rst Computer Aided Design/Drafting (CAD) 
software applications in the world.
The fi rst version of AutoCAD was released at the end of 1982, and it was 
designed to be used only on PCs.
Since 1982, AutoCAD has increased dramatically on a global scale.
Users can draw both two-dimensional (2D) drawings and three-dimensional 
(3D) designs in AutoCAD.
There is another version of AutoCAD called AutoCAD LT that is dedicated 
to 2D drafting only.
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1.2 HOW TO START AUTOCAD® 2010

There are two ways to start AutoCAD 2010:
While installing AutoCAD 2010, the installation program will create a 
shortcut on your desktop. To start AutoCAD, simply double-click this icon. 
From the Windows taskbar click Start/All Programs/Autodesk/
AutoCAD2010/AutoCAD2010.

AutoCAD will start with a new, open drawing fi le, which will look like the 
following: 
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1.3 UNDERSTANDING THE AUTOCAD® 2010 INTERFACE

The primary methods to reach commands in AutoCAD 2010 will be through 
Ribbons and the Application Menu.
You will use Ribbons instead of the normal toolbars.
This interface will give you more space in the Graphical Area, which is 
your drawing area.
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Graphical Area

Ribbon
Quick Access Toolbar

Application Menu

Info Center

Crosshairs

Command Window
Status Bar
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Application Menu

Click on the Application Menu, and you will see the following:

Using this menu, you can:
Create a new fi le
Open an existing fi le
Save the current fi le
Save the current fi le under a new name (Save As) and/or in a different folder
Export the current fi le to a different fi le format
Print the current fi le
Publish the current fi le
Send the current fi le to eTransmit or email
Use all the functions related to your drawing
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4 Chapter 1 Introduction to AutoCAD 2010

Close the current fi le
Exit AutoCAD

Quick Access Toolbar

The Quick Access Toolbar is the small toolbar located at the top left of 
the screen:

Using this toolbar, you can:
Create a new fi le
Open an existing fi le
Save the current fi le
Undo and redo
Print the current fi le

Ribbons

Ribbons consist of two parts:
Tabs
Panels

For example, the Home tab consists of eight panels: Draw, Modify, Layers, 
Annotation, Block, Properties, Utilities, and Clipboard.
In each tab you will see different panels.
The following is the Draw panel:

Some panels (such as the Draw panel) have a small triangle near the title, 
which indicates that there are more buttons available. If you click on it you 
will see the following:
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At the lower left-hand corner of the panel you will see a small pushpin. If 
you click on it, this will be the default view. To return to the previous view, 
simply click the pushpin again.

Some panel buttons may have a small triangle just to the right, which means 
there are additional options, as shown here:

If you hold your cursor over any button for one second, a small help screen 
appears:
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6 Chapter 1 Introduction to AutoCAD 2010

However, if you hold your cursor over the button for three seconds, you will 
see an extended help screen:

Panels can be docked or fl oating. By default, all panels are docked. To make 
a panel a fl oating panel, simply click on the name of the panel, hold it, and 
drag it to its new location. 
If all panels remain docked, you will not see any panel outside the tab it 
belongs to. But if you make any panel a fl oating panel, then you will be able 
to see it in all other tabs.
While the panel is fl oating, you will see two small buttons on the right-hand 
side. The following image shows the function of each one:
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All panels have two orientations: a vertical orientation and a horizontal 
orientation. The following illustration shows the tabs and panels that appear 
for both orientations. 

   →    

  →   

The number of tabs and panels are predefi ned by default.
You can turn off/on any tab/panel by right-clicking on any tab/panel and then 
selecting the desired tab/panel to be turned on or off.

Ribbons have three different shapes. You can alter the shapes by clicking 
the small arrow at the right:
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8 Chapter 1 Introduction to AutoCAD 2010

InfoCenter

At the top-right part of the screen, you will see the InfoCenter:

The InfoCenter gives you the opportunity to type in keywords that will 
enable AutoCAD to search both online and offl ine resources and provide 
you with a list of related help topics. See the following example:

You may still use the conventional Help search by clicking the arrow at the 
right-hand side of the InfoCenter:

Command Window

If you used AutoCAD 25 years ago, the only way to input commands was to use 
the Command Window. You had to memorize all of the AutoCAD commands 
and type them in. There were no menus, toolbars, panels, or ribbons. Although 
you can still type in the commands, we don’t recommend that method.
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Graphical Area

The Graphical Area is where you do your actual drawing. You use the 
crosshairs to specify points in the X,Y plane.
You can monitor the coordinates of the crosshairs using the left side of the 
Status Bar.

Status Bar

The Status Bar in AutoCAD contains many functions that will help you 
draft more precisely. We will discuss most of the buttons on the Status Bar 
throughout this book.
There are two views for the Status Bar:

By default (Icons)

Buttons

To switch views, right-click the Status Bar to alternate between buttons 
and icons. 

If you select Use Icons, the view will change accordingly.

1.4 POINTS IN AUTOCAD®

Points are defi ned (and saved) in AutoCAD using the Cartesian coordinate 
system.
The coordinates will look something like 3.25,5.45, which is the format of X,Y.
So the fi rst and most traditional way of specifying points in AutoCAD is 
to type the coordinates whenever you are asked to do so, by typing X,Y 
(pronounced X comma Y). See the following illustration: 
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10 Chapter 1 Introduction to AutoCAD 2010

1.5 AUTOCAD® DEFAULT SETTINGS

Sign convention: positive is up and right.
Angle convention: positive is counterclockwise (CCW) starting from the east 
(i.e., 0 angle). See the following illustration:

1.6 THINGS YOU SHOULD KNOW ABOUT AUTOCAD®

The mouse is the primary input device:
The left mouse button is always used to select and/or click.
The right mouse button, when clicked, offers a drop-down menu.

The mouse wheel has zooming functions:
Zoom in on your drawing by moving the wheel forward.
Zoom out of your drawing by moving the wheel backward.
Pan (i.e., move through the drawing) by pressing the wheel and holding 
it and then moving the mouse.
Zoom to the edges of your drawing by double-clicking the wheel.

If you type an AutoCAD command or any input in the Command Window, 
you have to press the [Enter] key to execute it.
[Enter] = [Spacebar] in AutoCAD.
To repeat the last AutoCAD command, press [Enter] or [Spacebar].
To cancel any AutoCAD command, press [Esc].

1.7 DRAWING LIMITS

AutoCAD offers users an infi nite drawing sheet on all sides.
When you start a new AutoCAD drawing, your viewpoint will be at 0,0,1.
You are looking at the X,Y plane, using a camera’s lens; hence you will see part 
of your infi nite drawing sheet. This part is called the limits. See the following:
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In this example, you can see that the limits of the drawing are from 0,0 
(lower left-hand corner) to 12,9 (upper right-hand corner). This is your 
working area.
We will learn how to change limits in upcoming chapters.

1.8 UNITS AND SPACES

One of the vague facts about AutoCAD is that it does not deal with a certain 
length unit while drafting. Take note of the following points:

AutoCAD deals with AutoCAD units.
An AutoCAD unit can be anything you want. It can be a meter, centimeter, 
millimeter, inch, or foot.
All of these options are correct as long as you remember your chosen 
option and stay consistent in both X and Y.

Also, there are two spaces in AutoCAD, Model Space and Paper Space 
(Layout). You can switch between the two spaces using the Status Bar. 
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 Paper Space (Layout) button

Model Space button
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12 Chapter 1 Introduction to AutoCAD 2010

By default, when you start a new drawing fi le, you are in Model Space.
In Model Space you can create and modify your drawing.
Once you are ready to make a hardcopy of your drawing fi le, switch to the 
Paper Space (Layouts) so you can prepare your page setup.
This is the moment you need to ask, “What is my unit assumption?” so that 
you can properly scale your drawing.
We will discuss printing in a later chapter.

1.9 VIEWING COMMANDS

We already discussed using the mouse wheel for zooming in, zooming out, 
and panning.
You can also zoom in, zoom out, and pan using the zooming and panning 
commands.
If using Ribbons, make sure you are in the View tab, and, using the 
Navigate panel, select the fi rst button on the left, or the small arrow, to see 
a list of zooming commands:
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Zoom Extents is used to zoom to all objects.
Zoom Window is used to specify a rectangle. By specifying two opposite 
corners, whatever is inside the rectangle will look larger.
Zoom Previous is used to restore the previous view, up to the last ten 
views.
Zoom Realtime is done by clicking the left button on the mouse 
and holding it. If you move forward, you are zooming in; if you move 
backward, you are zooming out. 
Zoom Dynamic is used with the Zoom Window fi rst. You will see the 
whole drawing and your current place (shown as a dotted green line), go 
to the new location, and press [Enter].
Zoom Scale is used to input a scale factor. If you type in a number less 
than 1, you will see the drawing smaller. If the scale factor you type in is 
greater than 1, you will see the drawing larger. If you put the letter x after 
the number (e.g., 2x) the scale will be relative to the current view.
Zoom Center is used to specify a new center point for the zooming, 
along with a new height.
Zoom Object is used to zoom to certain selected objects. AutoCAD will 
ask you to select objects and the selected objects will fi ll the screen.
Zoom In is not really a zoom option, but rather a programmed option 
equal to the Zoom Scale with a scale factor of 2x.
Zoom Out is just like Zoom In, but with a zoom factor of 0.5x.

Also on the Status Bar, you can use the following two buttons:

1.10 CREATING A NEW FILE

To create a new fi le based on a premade template, click on the New button 
on the Quick Access Toolbar:
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14 Chapter 1 Introduction to AutoCAD 2010

The following dialog box will appear:

This dialogue box will allow you to select the desired template.
AutoCAD template fi les have the extension *.dwt.
AutoCAD 2010 has lots of premade templates you can use, or you can create 
your own template.
For now, we will use acad.dwt for some of our exercises.
Click Open to start a new fi le.

1.11 OPENING AN EXISTING FILE

To open an existing fi le for further editing, click the Open button from the 
Quick Access Toolbar.
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The following dialog box will appear:

Specify the hard drive, and the folder your fi le resides in.
AutoCAD drawing fi les have the extension *.dwg.
If you want to open a single fi le, select the fi le and click open (you can also 
double-click on the fi le’s name).
If you want to open more than one fi le, select the fi rst fi le name, then hold 
the [Ctrl] key on the keyboard, and click the other fi le names.
You can open as many fi les as you wish.
When you are done, click Open.

Quick View

If you open more than one fi le, you can use two functions in the Status Bar: 
Quick View Drawings and Quick View Layouts.
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Quick View Drawings
Quick View Layout
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16 Chapter 1 Introduction to AutoCAD 2010

If these two buttons are switched on, you will see the following:

You will see all of the open fi les.
In order to jump from one fi le to another, click the window of the desired fi le.
When you hover over any of the fi les, you will see the layouts of the fi le, and 
the picture will change to:

Also, you will see a small toolbar at the bottom of the screen that will enable 
you to:

Close the Quick View
Open a fi le
Start a new fi le
Pin Quick View Drawings

If you right-click the Quick View button of any fi le, the following menu will 
appear:
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You can close all fi les
Close other fi les except the current fi le
Save all fi les
Close the current fi le

Organizing Files

Make sure you are in the View tab on the Ribbon. There are several ways 
to organize the fi les by using the Windows panel.

The Switch Drawings button will show you a list of the opened fi les. The 
current fi le will be listed with a checkmark (P). If you want another fi le, 
select the name of the desired fi le.
The rest of fi le commands, such as Save, Save As, and Exit, are identical to 
those in other Windows applications.

INTRODUCING AUTOCAD® 2010

 Exercise 1
1. Start AutoCAD 2010.
2. From the Quick Access Toolbar, click the Open button.
3. Go to the Samples folder under the AutoCAD 2010 folder. Open the following 

three fi les:
a. Blocks and Tables—Metric.dwg
b. dbsamp.dwg
c. Architectural and Annotation Scaling—Multileader.dwg

4. Using Quick View Drawings, jump from one fi le to another. Using 
Quick View Layouts, take a look at the layouts in each fi le.

5. Using one of the open fi les, use the mouse wheel—like any of the other 
methods discussed in this chapter—and zoom in, zoom out, and pan.

6. Using the right-click menu on the Quick View Drawings, close all fi les 
without saving.
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Tile Horizontally

Tile Vertically

Switch Drawings
Cascade Files
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18 Chapter 1 Introduction to AutoCAD 2010

CHAPTER REVIEW

1. You can close all open fi les using one command:
a. True
b. False

2. CAD stands for________________________________________________.
3. In AutoCAD there are two available spaces: Model Space and Paper 

Space. Which of the following statements is true?
a. You draw on Model Space and print from Paper Space.
b. You draw in Paper Space and print from Model Space.
c. There is only one space in AutoCAD.
d. Model Space is only for 3D design.

4. Positive angles start from the north.
a. True
b. False

5. AutoCAD is one of the few software applications that allows users to:
a. Connect to the Internet.
b. Type commands using the keyboard.
c. Accept Cartesian coordinates.
d. Create positive angles that are CCW.

6. _________________ is a tool in AutoCAD that allows users to see all open 
fi les in small windows.

CHAPTER REVIEW ANSWERS

1. a
2. Computer Aided Design/Drafting
3. a
4. b
5. b
6. Quick View Drawings
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